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This Document Provides Instruction For: 
Requesting Credentials to the EPA Sanitary Survey App for Marine and Fresh Waters 

• Request Access Credentials (Username and Password) [jump to section] 

Accessing the Survey123 Application 
• Option A. Instructions for downloading the Survey123 app on your smart phone or tablet 

[jump to section] 
• Option B. Instructions for downloading the Survey123 app to your computer or web 

browser [jump to section] 

Steps for Downloading and Using the Sanitary Surveys in Survey123 
1. Instructions for downloading the sanitary surveys in the app [jump to section] 
2. Tips on completing the survey [jump to section] 
3. Instructions for submitting and saving sanitary surveys [jump to section] 

Viewing and Exporting Your Sanitary Survey Data 
• Option A. Retrieving data using the Data Export Tool [jump to section] 
• Option B. Retrieving data using the Survey123 Website [jump to section] 
• Option C. Retrieving data using EPA’s ESRI GeoPlatform [jump to section] 
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Request Access Credentials (Username and Password) 
Before you can access the EPA Sanitary Survey App for Marine and Fresh Waters you will need to 
request a username and password from EPA. Go to https:/r9data.response.epa.gov/request/ to 
request your credentials using the GeoPlatform User Account Request Form (Figure 1). All fields on 
the form will need to be completed and click the box “I’m not a robot”. For the Response/Project, 
select Freshwater and Marine Sanitary Survey. 

At time of account creation, your account will be set to a General User which only has permission to 
submit, view, edit and download your own data. 

 

 

Figure 1. Sanitary Surveys GeoPlatform User Account Request Form 
 

After the GeoPlatform User Account Request Form is submitted, you will receive a username and 
temporary password within 48 hours. Your access credentials will allow you to access the surveys 
using Survey123 on your smartphone, tablet and computer as well as download your data from EPA’s 
Geo- Platform (see detailed instructions on the following pages). 

• External users (i.e., non-EPA), when you sign into the ArcGIS Online (see Step A.2a), you 
will be prompted to change your password. External users will also be required to 
complete multifactor authentication (MFA) for their accounts. There are two ways to 
authenticate your account – using Login.gov or a desired authenticator for mobile 
devices. Instructions to complete the MFA process can be found in Appendix A [jump to 
section]. 

• EPA user accounts will be linked to their LAN User ID after requesting access to the App. 
All EPA staff are automatically granted a full GeoPlatform organizational account the 
first time they access it. Staff can request access to the surveys by emailing 
EPA_SanitarySurveyApp@epa.gov and will be automatically added to the group. Follow 
the instructions in Step A.2b to login into ArcGIS Online. 

https://r9data.response.epa.gov/request/
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This section contains instructions for accessing the EPA Sanitary 
Survey App for Marine and Fresh Waters using the Survey 123 
app on a mobile device (e.g., phone, tablet) and a web browser. 
The Survey123 app and the EPA Sanitary Survey App should be 
downloaded before going into the field. By downloading the sur- 
veys in advance, you will be able to access and complete them 
without the need for WiFi or an Internet connection. 

 
 

Option A: Instructions for Downloading the Survey123 App on Your Smart Phone or 
Tablet 

 
Step A.1: Download Survey123 Application to Use the EPA Sanitary Surveys for Marine and Fresh 
Waters 

Download and install the Survey123 application (Figure 2) onto 
your mobile device from the Google Play Store or Apple app store. 

 
 
 
 

Figure 2. Icon for Survey123 
 
 
 
Step A.2a. Sign in to Survey123 for External Users 

(1) Enter the username and temporary password 
provided to sign into ArcGIS Online (Figure 3). Note 
that the extension “EPAEXT” in the username is not 
case sensitive. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3. Login Screen for ArcGIS Online 

(1) 

 
Important 

If there is no WiFi or Internet 
connection in the field, down- 
load the surveys before going 
into the field to conduct the 

sanitary survey. 

https://play.google.com/store/games?device=windows
https://www.apple.com/app-store/
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Password Tip 

• Password must not match username 
• Cannot be same as old password 

• Must be at least 13 characters long 
• Contain at least 1 letter(s) (A-Z, a-z) 
• Contain at least 1 number(s) (0-9) 
• Must be different from the last 12 

passwords 

(2) 

(3) 

(2) Once you have logged in for the first time, you will be prompted 
to change your password (Figure 4). Enter the old password and 
then a new password and re-enter new password in Confirm 
password following the password tips provided. 

 
 
 

Figure 4. Password change screen 
 
 
 
 

(3) You will then be prompted to enter a security question (Figure 
5). Once you’ve completed this step you will see the My Survey 
123 home screen and you can begin downloading the surveys 
by following the steps for downloading and using the sanitary 
surveys. 

 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 5. Security question screen Note 

If you are unable to access the surveys, please 
contact EPA_SanitarySurveyApp@epa.gov. 

mailto:EPA_SanitarySurveyApp@epa.gov
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(1) 

(2) 

A.2b. Sign in to Survey123 for EPA Users 

(1) Select Your ArcGIS organization’s URL (Figure 6). 

(2) Type in “EPA” (not case sensitive) as the organization and select Continue (Figure 7). 

(3) You will then be redirected to a second screen (Figure 8). Select EPA Enterprise again. 

(4) Select the Login.gov when prompted to “Select a Login Method” (Figure 9). 

(5) You will then be redirected to the Login.gov screen to select LOGIN. 

(6) Agree to the privacy policy. 

(7) Enter your email address and Login.gov password or select “Sign in with government employee ID 
(Figure 10).” 

(8)  Check the box to accept the Login.gov Rules of Use and Continue. 

(9) Choose Present PIV/CAC card or click the link “choose another authentication method: (a) Text, (b) 
Automated phone call, or (c) Government employee ID and continue (Figure 11). 

(10) Enter One-time code, select “Remember Browser” and Submit (Figure 12). 

 
 

Figure 6. EPA user login in Figure 7. Enter “EPA”  
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(3) 

(4) 

(4) 

Figure 8. Select EPA Enterprise Figure 9. Enter your LAN username and 
password or log in with your PIV card 

Figure 10. Login.gov Sign In Figure 11. Choose Authentication         
Method  

*Please note that the green arrows refer to the steps described in section A.2b.

Figure 12. Enter One-Time Code 

(7) 

(10)
 

(9)
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Option B: Instructions for downloading the Survey123 app to your Computer or Web 
Browser 
Step B.1. To access go to: https://epa.maps.arcgis.com/home/index.html. Then click on the Sign In 
button on the top right corner (Figure 13). 

Figure 13. GeoPlatform main screen 

Step B.2. To sign in, external users will need to 
follow Step A.2a, while EPA users will need to 
follow Step A.2b. These steps are on pages 
3 - 5 (Figure 14). 

Figure 14. Sign in window 
Step B.3: Select Groups on the main menu (Figure 15). 

Figure 15. GeoPlatform main menu after logging in 

EPA users 

External users 

https://epa.maps.arcgis.com/home/index.html
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Step B.4. Select the Group Freshwater and Marine Sanitary Surveys – General Users (Figure 16). 
In the Recently added content (Figure 17) you can view some of the surveys. Select View All Group 
Content at the top of the icons (shown in Figure 17) or at the bottom of the page to see all of the 
surveys. 

Figure 16. Freshwater and Marine Sanitary Surveys -- General User-Group 

You will find four types of files in this folder for each of the sanitary surveys: a Web Map, a Form, 
and two Feature Layers. You can hover over the icon to see the name of the file type. Web Maps and 
Feature layers are part of each survey form and the Form pulls data from each of these files. 

Feature Layer for 
User Permissions 

Form Feature Layer for 
Accessing Data 

Web Map 

Figure 17. Sanitary survey files types on the EPA GeoPlatform 
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Step B.5. Select only the Form (i.e., with the swimmer pictogram or 
paper icon in Figure 17) by clicking on the name of the survey 
form (e.g., Marine Sanitary Survey). Once the form opens, you can 
choose to either open the survey in the browser or in the Survey123 
app. Click on Open in Survey123 drop-down menu, and then select 
Open in browser or Open in Survey123 app (Figure 18). If you select 
the Open in Survey123 app, you will be redirected to a download 
page. 

Figure 18. Opening Survey123 from your browser 

Step B.6. Click Download to download the Survey123 
app. You will be redirected again to the ArcGIS Survey123 
Resource Page to download the appropriate ArcGIS 
Survey123 app for your processing system (Figure 19). 

Step B.7. Once you’ve downloaded the Survey123 app 
on your computer, follow the steps for downloading and 
using the sanitary surveys on pages 3 - 5. External users 
will need to follow Step A.2a, while EPA users will need to 
follow Step A.2b to sign in. 

Figure 19. Download for your 
processing system 

Note 

After clicking on the sur- 
vey form, the name list- 
ed here will not be yours 
but rather the name of 

the developer. 
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1. Instructions for Downloading the Survey in the App

Step 1: Download EPA Sanitary Surveys in Survey123 

As a first-time user of the App, once you log into the Survey 123 
app with your credentials, you should see an image like Figure 20 
that says, “Looks like you don’t have any surveys on your device.” 
Select Download Surveys. Then go to Step 2a. If you had previously 
downloaded surveys or if a new version of the survey is released, 
you will need to update your surveys to the latest versions (see 
Step 2b). 

Step 2a: Downloading Surveys for First Time 

Select the sanitary survey(s) you wish to download to your device: 

• Marine Routine Survey
• Marine Annual Survey
• Freshwater Routine Survey
• Freshwater Annual Survey

There may be a slight delay in seeing the surveys because they are 
loading. Downloads occur one at a time by selecting each download 
icon next to each survey. After downloading the surveys for the 
first time, go to Tips on Completing the Survey (page 12) or Instruc- 
tions for Submitting and Saving Sanitary Survey Data (page 14). 

Step 2b: Downloading Newer Versions of Surveys 

Periodically, EPA will make updates to the surveys and you will 
need to download the latest versions of the surveys before you 
can begin using them. When downloaded, newer versions of the 
surveys will appear on your My Surveys page and will replace 
previously downloaded surveys on your device.  

You may see on your My Surveys screen, notification that there 
are updates available. There may be instances where you may 
need to delete an old survey before downloading a newer 
version. Follow these instructions when downloading newer 
versions. 

Delete old surveys first: There isn’t a batch process to delete all 
old surveys at once, so each old survey will have to be deleted 
individually. To delete old surveys, open each survey by clicking 
on the survey icon; and then click on the triple horizontal bars on 
the upper right-hand corner (Figure 21); and then click Delete 
Survey. Make sure you do it for each survey. 

Figure 20. Download surveys in 
Survey123 

Figure 21. How to delete surveys 

10  
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After deleting all old surveys, you can proceed with downloading the newer versions. Figure 22 is the 
notification you will see on your My Surveys screen when updates available. 

Figure 22. Updates available notification 

To download the latest versions, begin by selecting the Person icon  in Figure 22 or your initials 
(this is the icon to the right of  icon on the top right of the page). 

Click to download the survey. A list of surveys to be updated will appear. If the 
survey needs to be updated, it will have a cloud icon  next to it. Click the cloud icon next to each 
survey. 

From time to time, based on user feedback and enhancements, the surveys will be updated. EPA 
will notify users when newer versions of the surveys have been released, so users can ensure they 
are using the latest versions. These instructions can be used to download newer versions of the 
surveys. 

Return to My Surveys by selecting the back arrow. 

Step 4: Opening the Survey 

Select the survey you plan to complete by clicking on the survey icon (e.g., the marine annual survey 
has this icon). 

Click the Collect button at the bottom of the screen to open 
the survey to begin entering your sanitary survey data. 

Give Survey123 permission to access your location or camera 
data to allow for full application functionality. 

Step 5: Begin Collecting Data 

To begin entering data, use the navigation arrow buttons at 
the bottom of the screen (Figure 23) to navigate through the 
sur- vey pages. 

Navigation arrow button 

Figure 23. Freshwater Routine Sanitary 
Survey - Page 1 
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Embedded questions that appear when you select Yes for certain responses in certain 
sections of the surveys. Below is an example of how Part 3: Bather Load expands to 
show embedded questions after selecting “Yes.” 

Questions with repeats allow you to enter data for up to 10 entries. In the example below, 
press “+” to add more entries

Click here to add more 
entries 

2. Tips on Completing the Survey

Survey Features 

While several questions at the beginning of the survey are required (as indicated by a red asterisk, 
*) most of the survey questions are optional. As you enter the data, you will see the following 
features: embedded questions when entering certain responses; questions with repeats that allow 
you to enter data for up to 10 entries; sections that collapse to hide information and reduce length 
of survey; and sections for taking (multiple) photos. See the screenshots to learn more about these 
features. 
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Sections for taking or uploading (multiple) photos. In the example below, press “+”
to add more photos. 

Sections that collapse to hide information and reduce length of survey. In the example 
below, pressing the arrow on the top left will collapse the bacteria samples section 
and “+” to expand the section. 

Expand 

Click here to launch 
the camera on your 
device 

Collapse or 
Expand 

Click here to upload 
photos from a file on 
your device 

Click here to add 
more entries 
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3. Instructions for Submitting and Saving Sanitary Survey Data

Submitting the Survey 

Step 1. Once you’ve completed the 
survey, use the check button at 
the end of the survey to validate the 
submission (Figure 24). Once the app 
checks that all the required fields are 
filled in, the survey will be considered 
complete and ready to be submitted to 
the EPA GeoPlatform. 

If you don’t click the check button, 
your work will not be saved. 

Validate submission 
“Check” Button icon 

Figure 24. Freshwater Routine Sanitary Survey 
- Page 6 

Step 2. The Survey Completed window (Figure 25) will appear with 
three choices – Send now; Continue this survey; or Save this sur- 
vey in the Outbox. 

• Send now: This will upload your data to the EPA GeoPlat- 
form if you have WiFi or Internet access. Once your data
is on the GeoPlatform you can view and download.

• Save this survey in the Outbox: This will save your survey
to the Outbox folder on the main screen for the survey
below the Collect button. Select this option if your
device is offline or you have no WiFi or Internet access.

Once you have reconnected to WiFi or the Internet, 
return to the saved survey in the Outbox to submit 
your survey to the EPA GeoPlatform. 

All surveys sent to the EPA GeoPlatform are saved to a Sent 
folder on the main screen for the survey below the Collect button 
(Figure 29). These surveys can be edited and resubmitted or 
data can be copied to a new survey (Figure 26). An edited and 
resubmitted survey will replace the previously submitted data. 
Surveys submitted can also be viewed in the Inbox (Figure 29). 
Select Inbox and then Refresh to load the surveys you have 
submitted. 

Figure 25. Survey completed screen 

Figure 26. Edit or resubmit survey 
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Closing and Returning to your survey at a later time 

By clicking the close button in the top 
left-hand corner (Figure 27), you will 
be prompted to Save the Survey in the 
Drafts (Figure 28). The draft survey 
will be saved in a Draft folder on the 
main screen for that survey below the 
Collect button (Figure 29). To edit or 
complete the draft survey, reopen the 
same survey form again, select the 
Drafts folder and find the draft survey 
you want to complete. Begin adding 
additional information to complete the 
survey. 

Close button 

Tip 
Unable to complete 
a survey? That’s OK 

-- save your surveys as 
a draft and come back 

later Figure 27. Freshwater Routine Sanitary Survey 
- Page 6 

Figure 28. Saving the survey as a draft 

Survey Homepage 

Based on your selection in the previous steps, the intro 
page for your survey may look like Figure 29. 

• The Collect button will start a new survey
• The Inbox and Drafts buttons store surveys that

have been started but not yet submitted.
• The Sent button stores all surveys that have

been sent. Here you can edit and resubmit or
copy surveys as discussed on page 13 and 14.

The little notification numbers will update to match 
the number of surveys you have submitted and 

drafts that you have saved 

Figure 29. Freshwater Routine Survey intro page 
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Tip 

The Data Export Tool is the best way to view your data 
and photos. Use your computer not your smartphone to 

view and download data. 

It is best to view and download your data from a computer rather than your smart phone. There are 
three platforms which may be used to view and download your data (Option A using the Data Export 
Tool [jump to section], Option B using the Survey123 website [jump to section], and Option C using 
the EPA ESRI GeoPlatform [jump to section]). These three options are discussed in this section. The 
best way to view your data is with the Data Export Tool. 

Option A: Retrieving Data Using the Data Export Tool 
The Data Export Tool produces a customized report containing all the data collected for one or more 
surveys. Of the three options for downloading data, the Export Tool is by far the most straight-
forward method. The advantage to using this tool is that it combines all data including photos into a 
single downloadable file. 

Step A.1: Access the Data Export Tool 

• Open a web browser and navigate to the main page of the Export Tool (Figure 30)

https://geopub.epa.gov/sanitary-survey-data-export/welcome 

Figure 30. Data Export Tool Main Page 

• Click on the Click to begin button on the main page. This will open another page.

https://geopub.epa.gov/sanitary-survey-data-export/welcome
https://geopub.epa.gov/sanitary-survey-data-export/welcome
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Step A.2: Sign into the Export Tool  
Login using the same credentials (username and password) 
used to access the sanitary survey app (Figure 31). After signing 
in you will be prompted a second time to click on the Click to 
begin button.  

Step A.3: Select Survey to Download Data 

Click on the title or app icon of any of the surveys shown in 
Figure 32 to download your data for that specific survey. You 
can only download data from one type of survey (marine or 
freshwater, annual or routine) at a time. 

Figure 31. Data Export Login 

Figure 32. Select Survey to Download Data 

Step C.4: Download Data 

After you select your survey, Figure 33 will display showing a table with the individual surveys 
organized by Survey ID, Beach/Waterbody Name, and Survey data and a map with the locations 
surveyed.  
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Figure 33. List of surveys to be downloaded 

(1) Survey ID, Beach/Waterbody Name and Survey Date can be sorted by clicking on the
field name in the header row of the survey. Click on the box next to one or more
surveys you want to download. You can select all survey for downloading by clicking
on the box in the header. To deselect all surveys, click the box again.

(2) Additional surveys can be viewed by paging through the document using the forward
and back arrows.

(3) The default setting is to include photos with text and numeric survey data with each
download unless Include photo attachments is toggled off.

(4) By default, only 25 surveys are displayed per page, but you can display up to 100
surveys per page by selecting the down arrow next to Items per page to change the
default.

(5) After you select which surveys to download, click the CSV button below the table to
download your survey data or view/use in Excel or another database application. Click
the GIS button to download survey maps to view/use in ArcGIS or import into other
applications.

(6) Click the green arrow to download the data. Note that the arrow is green when
surveys are selected, otherwise it’s gray. A zip file of your data will be created for
downloading. Change the filename and click Save to a location on your device.

(7) Click to exit the Data Export tool.  
Figure 34 shows a sample of the downloaded data. Each survey is a separate row in the table. 

Figure 34. Sample of downloaded data 

2 3 

5 

7 

  6 

1 

4 
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Option B: Retrieving Data Using Survey123 Website 
The Survey123 website is tied to the GeoPlatform. They share users, groups, data, etc. The 
Survey123 website provides another option to view and export survey data collected with the EPA 
Sanitary Sur- vey App for Marine and Fresh Waters. 

 
Step B.1: Sign into the Survey123 website 

• Open a web browser and navigate to the EPA’s ESRI GeoPlatform 

https://survey123.arcgis.com/ 

• Log in with your username and password 
 
Step B.2: View your data 

Click on the My Surveys tab on the top of the page to view surveys you have access to view 
submitted data for in the Survey123 website (Figure 35). Surveys with data will appear with a 
record(s) number on the survey icon. 

 

Figure 35. My Surveys in Survey123 for ArcGIS 
To quickly access your data,

 

click this Data icon. 
 
Once you click on the survey icon for which you submitted data (Figure 35), you can view your data 
several ways: 

• The Overview tab provides high level information about the status of this survey such as 
summary information on the total number of surveys submitted, number of submitters, 
and the first and last date of data submission (Figure 36). 

• The Analyze tab provides functionality to analyze the answers to individual survey ques- 
tions. This feature is currently disabled. 

• The Data tab provides a map and table view of the data you have submitted. You can 
filter the data, generate reports, etc… and export your data in several formats (Figures 37 
and 38). 

https://survey123.arcgis.com/
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Figure 36. Overview tab Survey123 ArcGIS 
 
 

View your data in the Data tab 

Select Data (Figure 37). Note: If your survey data does not display 
as shown in the table below the map in Figure 37 you may need 
refresh your view (CTRL F5 [PC] or Command R [Mac]). In the data 
tab you can view your data in two ways: 

(1) View your data in the table at the bottom of the window (Figure 
37). You may need to adjust the table size by pulling the table 
tab up. Here you can toggle between data tables.  

1. View sections of the survey 

  Figure 37. View the data in a table in Survey123 ArcGIS  
Your survey data 

Adjust table size 

 

 
 

Tip 

If you’re having problems re- 
viewing your data click CTRL 
F5 (PC) or Command R (Mac) 

to reload data screen. 
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(2) View your data by clicking your sampling location point 
on the map (Figure 38). This will open a new window 
display to the right of the map where you can scroll 
through your data and photos as they appear in the 
sanitary survey app. 

2. View data inside display window 
 

 
Figure 38. View the data and photos in the side window in Survey123 ArcGIS 

 
Step B.3 Exporting Your Data 

To download survey data, on the Data tab, select Export in the toolbar above the map (Figure 39). 
Choose your preferred format for the export file. After some processing time, the file will download 
to your local workstation. Note: You can filter the results before exporting them. If you do this, the 
exported file will only contain the filtered data. 

To download your photos, select your sampling location point on the map (Figure 39). Scroll through 
this window to view photos. Right click on photos and select Save Image As to save photos. 

 

Export button to export data 

Figure 39. Exporting your data and saving your photos in Survey123 ArcGIS 
 
 

Right click, Save 
As to save 

 

Tip 

Click data points on your map to view 
data and photos in the side pane 



Retrieving your Sanitary Survey Data 

EPA Sanitary Survey App for 
Marine and Fresh Waters Instructions 22 

 

 

 
Option C: Retrieving Data Using EPA’s ESRI GeoPlatform 
 
Step A.1: Sign into EPA’s ESRI GeoPlatform 

• Open a web browser and navigate to the EPA’s ESRI GeoPlatform 

https://epa.maps.arcgis.com/home/index.html 

• Log in with your username and password 
 
Step A.2: Find your data 

• After logging in, click on the Groups on the main menu (Figure 15). 
• Select “Freshwater and Marine Sanitary Surveys – General User” (Figure 16). 

In the “Freshwater and Marine Sanitary Surveys – General User”, you will see Web Maps, Forms 
and Feature Layer files (see Step 3.4) for each survey. The data you submitted is stored in the Fea- 
ture Layer called “Access Your Data” for each respective survey (Figure 40). 

 
Step A.3: Access your data 

Click on the Feature Layer called “Access Your Data” for the survey for 
which data was collected (Figure 40). 

This will open the Access Your Data screen (Figure 41). From here, you 
can choose to view and/or export your data. 

 
 

Step A.4. View your data Figure 40. Access data icon 

Once you open Access Your Data (Figure 41), you can view your data several ways: 

• Using the Data tab to view data in tabular format (Figure 42). This is the best option for 
viewing your data and photos. 

• Using the Visualization tab to view data spatially (Figure 43). 
• Using the Map Viewer to view data in tabular and map forms (Figure 44). 

https://epa.maps.arcgis.com/home/index.html
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Tip 

The data tab is the best option for viewing your data 
and photos on the GeoPlatform 

 

Figure 41. View data submitted to the GeoPlatform 
 
 

 
 
 

View your data using the Data tab 

Figure 42 shows data for surveys conducted using the Data tab. Use the scroll bars at the bottom of 
the table to navigate through the various sections of the survey (from left to right). You may also 
use the drop-down menu to view specific sections of the survey. 

 
Figure 42. Data display from the data tab 

Dropdown Menu 
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View your data using the Visualization tab 

Figure 43 shows the data displayed spatially using the Visualization tab. When viewing data using 
Visualization, you may need to adjust the map (i.e., zoom in or out) to see your data point(s) on the 
map. Click on a data point to view the data collected. 
 

Figure 43. Data viewed using the visualization tab 
 

When there are many points in the same area of the map, you may need to disable or adjust the 
clustering to find your data. To do so, click on the Cluster Points icon shown in Figure 44 and the 
Enable Clustering menu will appear. You can also see how to scroll between multiple sam- ple 
points that are clustered closely together (the red dot may represent multiple data points). To see 
the clustered data points, click the small arrow on the top right corner of the data box to scroll 
between surveys.   

 

Figure 44. Disable or adjust clustering points to find sampling locationNot seeing all of your 

dataArrow to scrolls? Check the clustering settings or, in   

box, click the arrow on the right. 

Cluster Points 

Tip 
Not seeing all your data points? 

Check the clustering settings or, in 
the dialog box, click the arrow on 

the right 
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Figure 45. Data display in map viewer 

1. Adjust map size by moving up the map 
adjustment tool to view 

View your data using the Map Viewer 

Figure 45 shows data viewed using Map Viewer. Use the menu on the left-hand side to view the 
data for different parts of the survey. To see and toggle between tables in the Map Viewer, select 
the section of the survey you would like to see, then click the chart icon . You can also click on 
a data point on the map to view your data. To leave the map viewer, click the back button on your 
browser. 

 

2. View different parts of the survey by 
using this menu 

Step A.5. Exporting your data 

To download your data, click Export Data. All layers and tables will be exported as one zip file, or as 
individual layers/tables (Figure 46).  

Figure 46. Options for exporting data from the GeoPlatform 

Important 

You may need to adjust the 
map in order to view the data 
which is included as a row in 

the table below the map 

1. Export all data as a 
.zip file 

2.Export data from an 
individual layer/table by 

clicking on the file to open in a 
new window and select Export 

data. 
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When you choose to export data, it will not be exported im- 
mediately. Instead, you will have to save it as a new item in 
the EPA’s ESRI GeoPlatform. In this example, I have chosen 
to Export to a CSV file. You can provide your exported file a 
name, tags, etc. Click Enter to add one or more tags to 
activate the Export button. Add Summary (optional) and 
Change Save in Folder location. Click Export button to create 
a new item in the EPA’s GeoPlatform (Figure 47). 

 
 
 
 
 
 
 
 
 
 
 

 
Figure 47. Exporting data from GeoPlatform 

 
 

After exporting your new item, you will be routed to the new item’s page in the GeoPlatform. You will 
see a Download button on the right-hand side of the page. Click Download to download a .zip file 
to your local workstation (Figure 48). See Figure 49 for an example of the data output files in the 
.zip file. 

 

 

Figure 48. New items screen to download data 
 
Note that if you need to find this file again, click 
on the Content tab at the top of the page after 
logging into the GeoPlatform. This will take you 
to your Content “home,” where you will be able 
to view all content you own in the EPA’s 
GeoPlatform. 
 
 

Figure 49. Example exported data file 

Tip 

The export data button will not export the 
data immediately -- you will first have to 
save it as a new item in the EPA’s ESRI 

GeoPlatform. 

Photos will need to be downloaded  
separately; see Step A.6. 
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Step A.6. Download your Photos 

To find, view, and save your survey photos, select the 
survey section where photos were taken or sections 
entitled “Image Repeat” from the dropdown menu (Figure 
50) in the Data tab. 

 
 
 

 

Figure 50. Finding your photos 
You can view your photos by clicking on links under Photos and Files (Figure 51). This will open to 
the individual photo to allow you to view each photo. To save the photo, right click on the photo and 
then select Save Image As and specify where you would like the photo saved. This process will have 
to be repeated for each photo. 

 

 

Figure 51. Viewing and saving your photos 
  

Tip 

Find your photos in Image 
Repeat or in the sections 

of the survey where  
photos were taken 
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APPENDIX A  
Setting up Multifactor Authentication 

(MFA) for EPA GeoPlatform Online 
External Accounts 



Setting up Multifactor Authentication 
(MFA) for EPA GeoPlatform Online External 
Accounts 
 

This document contains Setup Instructions as shown using a mobile device and Frequently Asked 
Questions 

Setup Instructions 

EPA security rules now require multifactor authentication (MFA) for external users logging in to the EPA 
GeoPlatform Online (GPO). While MFA is enabled for all GeoPlatform users, it is up to everyone to set up 
their own authentication method. Setting up MFA is a simple process that is outlined in this document. 

1. Go to https://epa.maps.arcgis.com and sign in using the ArcGIS login 

 

  

https://epa.maps.arcgis.com/


 

2. After logging in, click your profile at the upper right hand of the screen and click My settings. 

 

 

 

3. In My settings, click Security, and then click Enable under Multifactor authentication. 

 

 



4. The Multifactor Authentication window will present three authenticator options. Download the 
desired authenticator to your mobile device and click Next. 

 

 

  



5. Use your authenticator app to scan the QR code in the Multifactor Authentication window. 

 

  

Example Scan 



6. In the authenticator app, choose the Other (Google, Facebook, etc.) option. Note: the example 
below uses the Microsoft Authenticator. 

 

 

7. Click Continue at the next window to acknowledge you are overwriting security for your GPO 
account. 

.  

  



8. The authenticator app on your phone will display a 6-digit code.  

PLEASE DO NOT USE THE CODE IN THE EXAMPLE BELOW 

 

 

9. Enter the code in your GPO web browser and click Verify. 

 

  



 

10. If you are able to login to the GPO using the code from your authenticator, you now have MFA 
enabled for your GPO account and you have completed the mandatory requirement. 
 

11. For additional assurance that MFA is enabled, go back to My Settings, click Security and note 
that the option to enable Multifactor Authentication is no longer available.  
 
NOTE: clicking “Disable” will remove MFA from the account and you will need to repeat the MFA 
process otherwise your account will become disabled. 

 

  



Frequently Asked Questions 

Installing an authenticator app on a phone is not an option for me. What alternatives are there? 
  

There are many compatible authenticator applications, including desktop and browser-based 
alternatives. Some popular ones include: 
  
https://login.gov/help/get-started/authentication-options/ 

• Android options: Google Authenticator, Authy, LastPass, 1Password. 
• iOS options: Google Authenticator, Authy, LastPass, 1Password. 
• Windows apps: 1Password, OTP Manager, Authy. 
• Mac apps: 1Password, OTP Manager. 
• Chrome extensions: Authenticator. 

   
Can I use more than one authenticator? 
  

Only one authenticator can be used at a time, so if you wish to switch authenticators, you must 
first disable MFA and then re-enable it with a different authenticator. Some of the 
authenticators (Authy, 1Password) can synchronize across devices to provide more flexibility. 

  
Can I use Login.gov? 
  

Yes, you may visit https://waa.epa.gov, login with your login.gov account, and select 
GeoPlatform from the list of communities to request access to. After your request is approved, 
you will be able to select EPA Enterprise instead of ArcGIS from the GeoPlatform login options, 
and login via Login.gov. You will be assigned a new username and will need to work with a GPO 
admin to migrate any content items. 

  
Is multifactor only for mobile devices? 
  

When multifactor authentication is enabled, it applies to any login - desktop or mobile browsers 
or applications like Survey 123 or ArcGIS Pro.  

  
When I scan the QR code shown with my authenticator app, the login says murphy.mark_EPAEXT - 
why? 
 

The GeoPlatform generates a QR code that is unique to your login. If yours says 
murphy.mark_EPAEXT it means you scanned the QR code from the first copy of this help 
document rather than the one generated in the GeoPlatform which is unique to your account. 
Please follow the instructions and scan your unique code in a web browser. 

 

https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Flogin.gov%2Fhelp%2Fget-started%2Fauthentication-options%2F&data=05%7C01%7Cminton.gabrielle%40epa.gov%7C82eebeba6afd42f8103a08da9c18a427%7C88b378b367484867acf976aacbeca6a7%7C0%7C0%7C637993926887611938%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=KfGQf3r3ncSH7H6EscCV0988C1zsu%2BlyGuIJIJlAi6M%3D&reserved=0
https://play.google.com/store/apps/details?id=com.google.android.apps.authenticator2&hl=en
https://authy.com/
https://lastpass.com/
https://1password.com/
https://itunes.apple.com/us/app/google-authenticator/id388497605?mt=8
https://authy.com/
https://lastpass.com/
https://1password.com/
https://1password.com/
https://www.microsoft.com/en-us/store/p/otp-manager/9nblggh6hngn
https://authy.com/blog/more-authy-innovation-onetouch-now-on-desktop/
https://1password.com/
https://itunes.apple.com/us/app/otp-manager/id928941247?mt=12
https://chrome.google.com/webstore/detail/authenticator/bhghoamapcdpbohphigoooaddinpkbai?hl=en
https://waa.epa.gov/


Guidance for using Login.gov with EPA GeoPlatform 
This document assumes that you have already created a login.gov account. The process for doing so is 
well documented here: 

https://login.gov/create-an-account/ 

If you wish to use your login.gov account to access EPA’s GeoPlatform, first visit https://waa.epa.gov 
where you will be prompted to login using login.gov.  

 

After successfully logging in, you will see a screen like this: 

https://login.gov/create-an-account/
https://waa.epa.gov/


 

Click “Agree and continue”, and you will be taken to a screen that looks like this: 



 

In order to use your login.gov account with EPA GeoPlatform, you must be a member of at least one EPA 
Web Community. The preferred community for EPA GeoPlatform is titled GeoPlatform.  



 

 You should then receive an email at the address you registered with login.gov indicating that your 
request for access has been received and is pending approval. Your EPA sponsor will review the request, 
and when the request has been approved, you should receive an email similar to the one below: 

---------- Forwarded message --------- 
From: <wam_support@epa.gov> 
Date: Fri, Sep 16, 2022 at 2:01 PM 
Subject: Approved - Request for GeoPlatform Application Access 
To: <exampleuser@domain.com> 

 
Dear Example User, 
 
Your request for access to the GeoPlatform Community has been approved. The next time 
you log in to the EPA WAA you will be able to access the Community. 
 
If you have any problems with your access, please contact the Community Manager. 
 
Sincerely, 
EPA WAA Manager  

mailto:wam_support@epa.gov
mailto:exampleuser@domain.com


 

Once you have received this email you may now visit EPA’s GeoPlatform at 
https://epa.maps.arcgis.com/, and select “EPA Enterprise” for login, go through the login.gov 
authentication, and will successfully log in: 

 

 

 

You will be assigned a userID that begins with x, followed by the first initial of your first name and the 
first six letters of your last name. You won’t be prompted to enter the userid, but it’s helpful to make 
note of it, particularly if you need to join groups or transfer content items between accounts. If you 
previously had an ArcGIS.com account, you may need to work with a GPO Admin to transfer your items 
and privileges between accounts.  
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